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Step 1: Login to DTS

http://www.defensetravel.osd.mil/

£  http://www.defensetravel.osd.mil/dts/site/index.jsp

Verify that web browser
has most up to date

W @ Defense Travel System - Welcome to DTS requirements to access
DTS.
’ Defense Travel System Search DTS l
A New Era of Government Travel Web Accessibility | Privacy and Security Notice
Browsar Compatibliity Check

Home Welcome to DTS!! Click here t Javascript ... o

: Browser Version............. ~
DTMO Website Welcome to the new era of government travel that can really take you DEFeRst Cookies. v
Training places. MANAGEMEI Jawva - Click here for more information
Travel Explorer Featuring the best practices in industry and plug-and-play components,

DoD Lodging™

Military travelers going First Time Users

TDY to millta%lnstallatlons

must check DoD lodging

ava”ab""y before maklng Click below to learn more about

DTS and the tools required for

S _Defence Travel Suctem streamlines the entire process involved in global
ravelAssistance I CAC required, fnse (DoD) trave.
Center (TAC)
Use up-to-
Ref
SRS date or Defense Travel System
Contacts t
Upda e Q0. below to begin using the Defense Travel System. System Stat
Find your Local DTA ystem Status
LOGIN TO DTS D DTS
DTSisa

Training

Click below to learn how to use
DTS and for additional training

D EWTS



http://www.defensetravel.osd.mil/

Step 2: Create Authorization

(1) Click
“Official Travel” ffense Travel System

AlenEmofGoemnentiee AT
Logoff

Official Travel - Others V¥V Traveler Sety Administrative ¥

(2) Select “Authorization/Orders” under
“Official Travel” drop down tab.

Vouchers

‘ ts
Local Vouchers i A Con
Group Authorizations/Orders D tN Current Departure -
urygdrizdauor:  uAz40ARCO81RSCCHAP S e Status Date yRe
Org Access:

No documents found.
Group Access:

Permission:

Next: Select Create New Authorization/Order

m Defense Travel System M
A New Era of Government Travel

Authorizations Youchers Local Vouchers

Group Authorizations

Authorizations [ Orders

Below is a list of your existing authorizations / orders. Please select the function (Edit, Print, etc_) corresponding to i
An authorization that contains a past dated trip cannot be processed. Changes and or updates must be made after

(3) Select “Create New
Authorization / Order”

Create New Authorization / Order

Existing Authorizations/Orders




=

Defense Travel System Official Travel
A New Era of Government Travel

SCr

Current Date: 03-02-

Choose Your Trip Creation Method

If you're selecting one of the following trip types and your travel does not cross the International Date Line
to access the new itinerary systam.

+ AA-ROUTINE TDY(TAD

+ AB-OPEN ALLOTMENT

+ AXCARRANGEMENTS OMLY

+ B-PERM CHG STA

+ D-HOUSE HUNTING

For all other options, CLICK HERE to continue to the legacy itinerary system

| Click here |

CLICK HERE |




My TDY Locations*

Arriving

(1) Enter Arriving/Departing
date and Location
“Davenport, FL 33896”

D ocatic

(2) Select
“Travel Mode”

Time of Day

L@ 06/01/2017

g 06/04/2017

My Trip Overview*

Leaving On [ 06/01/2017

Returning On [ 06/04/2017

Morning

Trip Duration Multi-Day

Leaving From Returning To Returning by
@® My Residence @® My Residence
Time of Day
O My Duty Station O My Duty Station
O 9 City or Zip () 9 City or Zip
My Trip Details (3) Select
R “Training Attendance”
Type* Purpose*
AA-ROUTINE TDY/TAD I TRAINING ATTENDANCE - I
Description

Yellow Ribbon Event 21-23 January 2018

1860 characters remaining

Conference/Event Name*
ot attending a conference

(5) Click here

Cancel

(4) Type in Yellow
Ribbon Event with
dates of trainin

-

Rental Car

No

@) Car

Morning

-

-

-

L+

(6) Click here



Rental Car is NOT authorized with out an
Approved ETP.

[Click here ]

Modify Search Select Rental Car for ‘
CAE - Columbia Metropolitan Apt, SC (USA) Skip This Car
Please Note: A Red Star (*) from 06/01/2017 through 06/01/2017
indicates a field is required.
RESERVATIONS SUMMARY:
* Pick-Up Date:

RENTAL CAR:  $0.00
[06/01/2017 | =l

: _
* pick-Up Time: Government Rates || Nor-Gavermment Rates |

05:30 AM v

* Drop-Off Date: Rental rates shown do not include the Government Administrative Supplemental fee
. . of $5 per day.
|06/01/2017 T
* Drop-Off Time: Cars rented under the Government's Car Rental Agreement include unlimited mileage
_ (except for one way rentals) and collision and liability insurance coverage in the
05:30 PM United States and its territories and possessions. Not all vendors provide insurance

coverage for specialty vehicles (e.g., vans, sport utility vehicles). In the event of an

arridant unth Ana Af thaca wshirlac 3 flaim ic filad Airactiu unith tha Cavarnmant har




Lodging thru DTS is NOT authorized. Strong
Bonds staff will make reservation for all attendees.

A New Era of Government Travel

ﬁ Defense Travel System Itineranpenses' Accounting  Additional Options  Review/Sign

RETURN TO LIST

Lodging Rllitiols

Modify Search Select Lodging for ORLANDO

from 10/07/2016 through 10/09/2016 il biise
Please Note: ARed Star (%) .
indicates a field is required. RESERVATIONS SUMMARY:
LODGING: $0.00

* Check-in Date:

ANINTINNAL




Trip Summary

)
Paymens intormtion

Email this Itinerary  Print this Itinerary

Air Travel Payment Summary:

Rental Car Payment Summary:

Add Mew Flight

Add New Rental Car

Ressrvation Skipped: RES: Columbia, 5C

. ) Add It Now
Dates: 06/01/17 - 06/01/17 :
o . Add It Now
Reservation Skipped:  MYRTLE BEACH, 5C Dates: 06/04/17 - 06/04/17

Lodging Payment Summary:

Add Mew Lodging

Ressrvation Skipped:  MYRTLE BEACH, 5C

Add It Mow
Dates: 06/01/17 - 0604417 Remove

Rail Payment Summary:

Other Ticketed Transportation:

Change TDV Location

Add Hew Rail

Add New Ticketed Transporiation

Save and Continue

| Click here |
| |

Proceed to the following page: | Expense - Non-Mileage V|




Step 7: Non-mileage Expenses

Add only authorized expenses per the MOI on this
screen, i.e. parking and toll expenses.

Use this screen to enter non-mileage expenses for your travel document. Select an expense type, or, if you cannot find the appropriate expense
type, enter a description in the box provided. Select "Save Expenses” to save the expenses to the travel document.

Reminder: CTO Fees are a reimbursable expense to the traveler when the transportation costs are charged to your Individual Government Travel
Charge Card (IBA).

Leave: 01-Jun-17 Return: 04-Jun-17

Hon-Mileage Expense #1

* telect Expensze Type: | V| * Cost: 5

view expense details/currency
- OR - | | calculator

Mon-Mileage Expense #5

* Select Expense Type: | V| * Cost: 5 |:|

view expense details/currency

- OR - | | calculator
(1) Click here to save any *Date: [06/01/2017 | [EEEH]
mm./dd/S ey
expenses you entered
= Reimbursement: |GG‘-‘C£-Ind1»’idual V|

I (2) Click here I

Save Expenses

Proceed to the following page: Expense - Mileage V|




Mileage Expenses

Leave: 01-Jun-17 Return: 04-Jun-17
Mileage Expense #1

Use this screen to enter mileage expenses for your trip. Click on the "Save Expenses" button to save these expenses.

* Expense Typef put Auto-TD'Y/TAD

(1) Select
“Pvt Auto-TDY/TAD”

g * Date:) [06/01/2017

| [5]+| (2) Enter Start Date I

TNy YTy

* Method of Reimbursement:

sl A T | W w0 | g

D Table of Distan

From:

To:

*miles [  x Rate 0.535 = Cost §

Create separate mileage expense for return trip mileage: |:|

| Fersonal Vl

(3) CIic here: _
New page will open

Mileage Expense #2

* Expense Type: |

v * Dﬂte=| |u5m4;2m? |

[ (4) Enter End Date I

* Method of Reimbursement:

*Miles | | x Rate

| --Please Select-- v

= Cost 5

SaueExpﬂ'lse-_:l

Procesd to the following page: Per Diem Entitlements /|




ﬁ Defense Travel System

A New Era of Government Travel

DoD Table of Official Distances (DTOD)

Use DTOD fo calculate mileage when traveling to a location using a personally owned vehicle (POV). Enter the Zip Code or City, State/Country for the "Traveling From" and "Traveling To" locations to calculate the

Enter City, and 2 character State/Country code to search within North America (e.g. Atlanta, GA)

Enter City, and 3 character State/Country code to search outside North America (e.g. Paris, FRA)

Eng (1) Enter zip code |

Traveling From: Traveling To:

29207 ‘Il o,

a

(2) Click
Here

Calculate Total:

From:

To:
Calculate Distance

Save Distance




(3) Select Location

Select the location

Show 10 W entries

City 4 State / Country

Columbia SC 29207 Columbia. SC, Richiand

Showing 1 to 1 of 1 entries Previous Next

(4) Enter Zip code

(5) Click here




(6) Select Location
10 v entries

City 4 State / Country Location
Bromolla SWE 295 72 Bromolia. SWE. Skane Lan

Gualov SWE 295 72 Gualbv, SWE, Skane Lan

Kristianstad SWE 295 72 Kristianstad. SWE, Skane Lan ¢

Myrtle Beach SC 29572 Myrtle Beach, SC. Horry

Turbah SAU 29572 Turbah. SAU. i«

Showing 1 to 5 of 5 entries Previous Next




Step 8: Mileage Expenses

Current Date:

:hicle (POV). Enter the Zip Code or City, State/Country for the "Traveling From" and "Traveling To" locations to calculate the miles for the entered mileage expense.

nta, GA)
ris, FRA)
Traveling To: Calculate Total:
20572 ‘ From : 29207 Columbia, SC, Richland

To : 29572 Myrile Beach, SC, Horry

i
(7) Click here —

Total Miles : 143

Save Distance l

(8) Click here




Mileage Expenses

Use this screen to enter mileage expenses for your trip. Click on the "Save Expenses” button to save these expenses.

Leave: 01-Jun-17 Return: 04-Jun-17
Mileage Expense #1

#

Expense Type: | pyt Auto-TDY/TAD

v " Date: [0e/01/2017 |
(mim.dd/yyy)

* Method of Reimbursement: | Personal W

Miles required to be cbtained from Defense Table of Distances

DoD Table of Distances

From: 29209,

To: 25572, (1) Mileage is visible now |
* Miles % Rate  0.535 = Cost § 78.11 (2) Check this box to

add return mileage
Create separate milsage expense for return trip mileage: g—
Mileage Expense #2
* Expense Type: | N

" Date: [06/04/2017 |

{mm.dd )

* Method of Reimbursement: | --Please Select-- v

| 532 Click here

*Miles [ | x Rate = Cost §

Proceed to the following page: Per Diem Entitlements L |




Constructed Travel Cost-Comparison Worksheet (CTW) “is
not required” for POV travel under 400 miles one way.

riuie L7LU7 LUlUllivid, o'v

To: 29572 Myrtle Beach, SC r | )
Message from webpage

x Rate 0.535

; You have selected a transportation mode that may require a
SISHE ol idlenge Sloes Tiorel @ Constructed Travel Cost-Comparison Worksheet to be completed and
included with the document via fax or scanning. The Worksheet is
located at http://www.dtstravelcenter.dod.mil/cnsttvl/ or within DTS
under Review/Sign>Pre-Audit.

v| * Date: |06/04/2017 -
| il Do you wish to continue?
(mm/dd/yyyy)

* Method of Reimbursement: | --Please q
*miles [ | xRate Lok ][ concel

Save Expenses I

Proceed to the following page: Per Diem Entitlements VI




(1) Verify that Mileage
expense to/from TDY
location is listed.

Mileage Expenses

Expenses Summary

o - E I | | I - | |
Use this screen to enter mileage expenses for your trip. Click on the "Save | Tm Date e me B To Mlles 7 COSt B ER
Expenses” button to save these expenses. Pvt Auto- | 06/04/2017 29209 29572 146.0 | S78.11 .
TDY/TAD Columbia, Myrtle A
Leave: 01-Jun-17 Return: 04-Jun-17 Add » i (oL | Seach, C | | |
: : Expense Pvt Auto-  06/04/2017 29572 29209 ' 146.0 S$78.11 Edit
TDY/TAD Myrtle Columbia, ==
. Beach, SC  SC Remove
Expense Type: | v| ; | pcath s { |
e Total Expenses: $156.22
* Date: |06/04/2017
(mm/dd/yyyy)
* Method of Reimbursement: | --Please Select-- v

*mites [ | x Rate = Cost §

+ View This Expense Type’s Defaults

3 Gk here

- Proceed to the following page: | Per Diem Entitlements V|




Lodging and meals are provided at no expense to
attendees. Edit each day to reflect correct Per Diem.

Per Diem Entitlements

Following is a list of per diem allowances for lodging and meals/incidentals for each day of your trip. The "edit" link allows you to change the
information {e.g., duty conditions, meals provided, etc.) for a specific date or date range. The "reset” link changes the per diem information to
the default rates for that date and location.

** The presence of two asterisks before the Location Name indicates one or more directed meals available for the day at the location were de-
selected, impacting the allowable meal reimbursement amount.

GSA State Tax Exemption Listing

Click here
Date Location i Reset Ldg Cost Ldg Allowed M&IE Allowed = Per Diem Rate Code A B|L _ D _ Qtrs
15600 $44.25
06/02/17 MYRTLE BEACH,SC » Reset $156.00 GOvCC- Pers;)nal 156 / 59 NONE
Individual
$156.00 $59.00
06/03/17 MYRTLE BEACH,SC » Edit » Reset $156.00 GOVCC- 2 156 / 59 NONE
S Personal
Individual | ‘
30.00 $44.25
06/04/17 MYRTLE BEACH,SC » Edit » Reset $0.00 GOVCC- P z ) 156 / 59 NONE
Individual e
Reset All

A i o




Step 9: Per Diem Entitlements

Lodging and meals are provided at no expense to
attendees. Edit each day to reflect correct Per Diem.

‘You may apply changes on this screen to a certain date or range of dates by medifying the "Values Apply Through" date. If required to change
the distribution to travelers, use the distribution method selectlon hst to change the distribution methed. Then, select the "distribute cost" link
to distribute appropriately to travelers.  GSA State

(1)Select last
day of the TDY

Location: MYRTLE BEACH,SC

Values Apply From Date: 06/02/2017

106/04/2017 |

Values Apply Through:

Per Diem Rates

Costs are total for all travelers. You may change your lodging costs below. Use the "View Expense Details / Currency Calculator” link for
expense details such as payment method, reimburseable, etc.

Per Diem Rate:

Lodging: » view expense details / currency calculator

M&IE: g |44 » view expense details / currency calculator

ULUNUY INCIGENTal AMOUNT - {USed T0 regUCe The aaily INCIJentat rate to e minimum. )
Check here if your AO determines the minimum default incidental rate applies for the above date or date range, nstead
of the applicable locality rate included in the daily amount for Meals and Incidentals.

[T, 1 Py Hlend o 2o cwnnea bl MO IE e oot b A o £eck oe lood dane of oo al)

Check here if you are beginning or ending your travel at a TDY location vice your permanent duty station.l !2! Click here l

Cancel These Entitlement Changes and Return | I Save These Entitlements I

Proceed to the following page: | Accounting Codes V\ Continue

[N




Step 9: Per Diem Entitlements

Lodging and meals are provided at no expense to
attendees. Edit each day to reflect correct Per Diem.

Following is a list of per diem allowances for lodging and meals/incidentals for each day of your trip. The "edit" link allows you to change the
information {e.g., duty conditions, meals provided, etc.) for a specific date or date range. The "reset” link changes the per diem information to
the default rates for that date and location.

** The presence of two asterisks before the Location Name indicates one or more directed meals available for the day at the location were de-

selected, impacting the allowable meal reimbursement amount. (1) Verify that
Lodging cost is “0”

GSA State Tax Exemption Listing

(2) Click here

Date Location Edit Reset Ldg Cost Ldg Allowed JME&IE Allowed PerDiemRate Code B L D Qfrs
$0.00 §44.25
06/02/17 MYRTLE BEACH,SC » Reset $0.00 GOVCC- Personal 156 / 9 NONE
Individual
Sl $59.00
06/03/17 MYRTLE BEACH,SC » Edit » Reset $0.00 GOVCC- 3 156 / 59 NONE
R Personal
Individual
20.00 $44.25
06/04/17 MYRTLE BEACH,SC » Edit » Reset $0.00 GOVCC- " 156 / K9 NONE
Individual Personal
R —

Reset All |

Proceed to the following page: Accounting Codes VI I Continue




Step 9: Per Diem Entitlements

Lodging and meals are provided at no expense to
attendees. Edit each day to reflect correct Per Diem.

Meals

If you would like to make changes to meals, select the appropriate meal code and applicable meal{s) for this date or date range:

(2) Check meals

) Full Rate [N ereaksast
provided per MOI
Elected
() Available Cost: 5

(1) Select
“Provided”

@ Provided

Qccasional

|} Special Rate
ULUNUS INCIGENTal AMOUNT - (USEd [0 reguce tne daily INCIJentat rate o the minmum.)

Check here if your AO determines the minimum default incidental rate applies for the above date or date range, instead
of the applicable locality rate included in the daily amount for Meals and Incidentals.

] In Place - {Used to increase the M&IE amount to 100% on first or last day of travel)

Check here if you are beginning or ending your travel at a TDY location vice your permanent duty stationl (3) Click here I

Cancel These Entitlement Changes and Return Save These Entitlements I

Proceed to the following page: Accounting Codes V] Continue




Step 9: Per Diem Entitlements

Lodging and meals are provided at no expense to
attendees. Edit each day to reflect correct Per Diem.

Following is a list of per diem allowances for lodging and meals/incidentals for each day of your trip. The "edit" link allows you to change the
informaticn (e.g., duty conditions, meals provided, etc.) for a specific date or date range. The "reset” link changes the per diem information to

the default rates for that date and location.

** The presence of two asterisks before the Location Name indicates one or

selected, impacting the allowable meal reimbursement amount.

GSA State Tax Exemption Listing

Date Location

06/02/17 MYRTLE BEACH,SC

06/03/17 MYRTLE BEACH,SC

06/04/17 MYRTLE BEACH,SC

Ldg Cost

$0.00

$0.00

$0.00

(2) Verify hat

Lodging cost is “0”

Ldg Allowed
$0.00
GOVCC-
Individual
$0.00
GOVCC-
Individual

$0.00
GOVCC-
Individual

Reset All |

Proceed to the following page:

M&IE Allowed Per Diem Rate Code

$44.25

Personal 156 / 59
$5.00

Personal 156 /59
544-25 156 ’I 59

Personal

MEAL

MEAL

MEAL

Accounting Codes

available for the day at the location were de-

B L DJjQtrs

X X X

(1) Repeat steps in
previous slide to add
provided meals:
Saturday: All 3 meals
Sunday: Breakfast

vl e Gk rere |




Step 10: Upload MOI (All Soldiers)

‘AII Soldiers must upload the Event MOI.

{ (1) Click here

Itinerary  Travel

"% Defense Travel System

A New Era of Government Travel

| RETURN TO LIST

Accounting  Additional Options  Review/Sign | (2) Click here

Non-Mileage  Mileage  Per Diem Entitlements  STITEIAETa - NaCIotRE ~

To fax in your receipts click "Print Fax Cover Sheet”, and follow the instructions on the cover sheet. Then five minutes after the fax transmission
is complete click "Refresh” to see receipts in the list. To upload receipts that you have scanned, click "Browse.." and after selecting the scanned

file click "Uplead". Click "view" to view the receipts. Te add or change notes on an existing receipt, under the "Notes” column select the field you
would like to change, edit the text, then click the "Save Notes" button.

' " 'You must have the free Adobe Acrobat Reader program installed on your computer to view receipts. Download the Adobe
Mtbe Ot r |Acrobat Reader program.

(3) Click here to access your computer
and select the MOI (PDF)

= Print Fax Cover Sheet

I (5) Click here |

» Upload Scanned Receiptsf| (4) File name appears here | LBrowse.. | Upload

Existing Receipts

Date CTW 1 (6) Type in appropriate notes  [es

View Remove
02-Mar-2017 ] l MOI | » View » Remove
(T =
Refresh I Save Notes (7) Click here | l sgz Click herel
Proceed to the following page: I Accounting Codes VI

| Continue




Select appropriate Line of Accounting (LOA) from “ Cross

Org LOA

Accounting Codes Expenses Summary
No accounting information available.
Select the appropriate accounting code for this trip. If there are multiple
accounting codes that are required for this trip, please select all that apply.
, _ AGR Enlisted | 18 DHR YR
Start Date: 02-Jun-17 » Find Accounting Label .
— R and Officers | TDY
Accounting Label: [ —Select--- M| Civilian Family | 18 DHR YR
Shared LOA: | ---Select to Add--- v members TDY
TPU Enlisted 18 DHR YRE
17 CHAPTRIT OFF
e 17 G ADT ENL A DT
lected Accoun§ll 17 G ADT OFF 9
17 G AT ENL TPU Officer 18 DHR YRO
There are no accoufll 17 G AT OFF please select from the above list
of labels. 17 G CHAP TDY ADT
1
17.C 580 A Proceed to the following page: Preview V|




l gli Verif

2) Verify expenses I
Accounting Codes Expenses Summary and amount
Select the appropriate accounting code for this trip. If there are multiple ' 17 G SB TDY
accounting codes that are required for this trip, please select all that apply. ! , !
' - - | Category Allowed | Actual |
Start Date: 02-Jun-17 » Find Accounting Label | LODGING ~30.00 50.00
_ M&IE $93.50 [ $93.50 |
s | MILEAGE Sts622 | stsezz.
Accounting Label: [ ---Select-— 7 [
DA240ARCO81RSCCHAP ; 7 G SB TDY Sub $249.72 $249.72
otal: ] =
Shared LOA: | ---Select to Add--- v|
Cross Org LOA: ---Select to Add--- v .
| | g‘s‘t",‘l"“’d e $249.72 $249.72
Selected Accounting Code(s)
To remove an accounting code that does not apply to this trip, select the
remove link corresponding to the accounting label to be removed. Please make
the LOA’s assigned have costs allocated to it.
LOA b
£ s View/Edit
Accounting Label Organization Acctg Code Remove
17 G SB TDY DA240ARCO81RSCCHAP | = view/edit > remove
' 3) Click here
Proceed to the following page: | Preview v|




Other Authorizations.

Dol mandates split disbursement for transportaticn, lodging and rental car expenses. Click here for memorandum

Other Trip Informaticn

Tn:pType: AA-ROUTIME TDW/TAD (1) Review you r trlp
Trip Purpose: TRAINING ATTENDANCE

Trip Description: ~ Strong Bonds Staff support detail on this screen
ﬁgﬂs:‘mce!ﬂent Mot Applicable

Owverall Starting Point Time Zone: EST (06)

Review the details for this trip below. To make edits, click on the links at the left to return to that section. If you have no changes proceed to

Itinerary: Le F . Columbia. 50

Edit ave From: olumbia,
Leave: 02-Jun-17

Reptal Car: Company: Comments to the Travel Agent:

Edit
En-Route: Mo ry
Costs 50.00
Location: b
Pick-Up: 01-Jun-17 12:00AM

LB e e § P AL R S AR § A NS § g R ga
Save And Proceed To Other Auths | 2) Click herel

- Proceed to the following page: | Other Authorizations b |




Step 13: Other Authorizations

Other Authorizations Available
Select Other Authorizations
ALTERNATE/DESIGNATED LOCATION

The following are the additicnal authorizations that were selected based on the trip details. Enter comments to yvour Approving Official in the
"Remarks" boxes provided.

|

ATM Advance Authorized

E-INVITATIONAL (selection not allowed, reguires E-1
trip)
EXCESS BAGGAGE

R AR OB BAL FaRE I » Add Additional Authorizations For This Trip H (1) Click link I

F&-RENEWAL AGREE LV SUPPORTING DOCUMENTS

Fiscal Vear Funds Other Authorizations
GOVT-OWNED VEHICLE AVAILABLE

Oooood

MANUALLY ENTERED EXPENSE(S)

(4) Type: Meals Provided
(2) Select: PERSTEMPO CODE E

Other Authorization Remarks

(Individual Trng) \
m— gl MEALS PROVIDED Ims Provided I
OFFICIAL CTO NOT USED

OTHER (5ee remarks below)

OTHER PRIVATELY-OWNED VEHICLE

PER. DIEM LOCATION FOOTNOTES PERSTEMPO CODE E

PERSONAL DEVIATION-ITINERARY /TRANS MODE {Individual Trmg)

PERSTEMPO CODE E (Individual Trng)
Objective cannot be satisfactorily accomplished less N » remove
expensively by correspondence, teleconferencing, or other

PERSTEMPO CODE A (Operation)

PERSTEMPO CODE B (Exercise)

O
O
0
O
0 2
O
O
O
[]

PERSTEMPO CODE C (Unit Tmg)

&

| Save and Proceed to Pre-Audits (6) Click here I
Proceed to the following page: | Pre-Audit V| m

PERSTEMPO CODE G (Duty in Garrison)

PERSTEMPO CODE H (Hosp in area of PD5)

PERSTEMPO CODE | (Disciplinary Event)

PERSTEMPO CODE J (Inactive Duty Trng)

PERSTEMPO CODE K (Muster Duty)

PERSTEMPO CODE L {Funeral Honors Duty) (5) COpy and paste:

PERSTENZO CODEL (Unknonn) Objective cannot be satisfactorily accomplished less

POV USE NOT ADVANTAGEOUS TO GOVERNMENT . .

RAT TRAVEL I5 FOR A DEPENDENT expensively by correspondence, teleconferencing, or other
(3) Click: Add appropriate means

Oooooooood

O VARIATIONS AUTHORIZED



Pre-Audit Trip

Help for this screen

Constructed Travel Worksheet

1. Reason Flagged

*  CONSTRUCTED TRAVEL
WORKSHEET

2.  Reason Flagged
+  LODGING NOT USED

Below are any items that were "flagged" for this trip. You must provide comments in the 'Justification to Approving Official’ text field for flagged
items. When you are finished, or if there are no flagged items, click "Proceed To Digital Signature.”

DoD mandates split disbursement for transportation, lodging and rental car expenses. Click here for memorandum

2 Items have been Flagged in this Travel Document

Item Description
+ A transportation mode of other

than Commercial Air or Government

Transportation may require a
constructed travel cost-comparison
worksheet to be completed and
included with the document via fax

or scanning.

Item Description

1 MYRTLE BEACH,SC: No lodging
reservations exist from 06/02/2017
to 06/04/2017

(2) Click to select
reason code “L7”

1) Type as s
* Justification to Approving Official <Help>

CTW not required. Travel is less
than 400 miles one way

hown |

* Justification to Approving Official <Help>

) - Conference or Event

l (3) Txee as ¢

Lodging directed per MOCT

{ (4) Click here ||>| Save And Proceed To Digital Signature |

hown |

| Digital Signature

S -




Digital Signature

Click below to stamp and submit this trip authorization for routing and approval. By submitting you are legally signing this document.

Document Action

* Submit this document as: | SIGMED S

Routing List: STRONG BOND

(1) Select “Yellow

D »”

Additional Remarks:

W

Pending Routing Actions
Awaiting Status Change To By
SIGNED
Document History
Status Date
CREATED 03027

| Submit Completed Document |<-I (2) Click hereI
to submit

Lewel

Time Mame

1156

» View Reasons for Audit Failures

The estimated transportation related expenses
and actual reimbursement may be reduced if
travel is completed using a different
transportation mode than authorized by vour AQ.

Remarks

Proceed to the following page:

e T e




QUESTIONS

PLEASE CONTACT
815t RSC Yellow Ribbon Team

Donna McGhee

donna.m.mcghee?.civ@mail.mil

Office: (803) 751-9546
Norris Thomas

Norris.d.thomas.civ@mail.mil

Office: (803) 751-9929
Katherine Wilkins

Katherine.a.wilkins.ctr@ mail.mil

James Martin

James.j.martin207.ctr@mail.mil
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